Introducao a Edicao de Mapas Para Half-Life e WorldCraft 

Introducao 

Para quem nao sabe, o Half-Life foi desenvolvido pela Valve Software, utilizando um "motor" muitissimo melhorado do Quake 1. Toda a parte de gerenciamento basico de personagens, armas, mapas, etc. foi desenvolvida pela id Software, que licencia este motor para terceiros desenvolverem seus jogos baseados nele, assim nao se perde tempo re-inventando tudo de novo. Este eh o caso do Half-Life, portanto quem ja tem experiencia em criacao de mapas para Quake 1, 2 ou 3, nao vai ter muitas dificuldades para conseguir fazer seus primeiros mapas para Half-Life. 

O editor "oficial" de mapas para Half-Life eh o WorldCraft (download aqui), desenvolvido por Ben Morris, mas a Valve se deu tao bem com ele que acabou comprando-o (o WorldCraft, nao o Ben), e hoje sao eles que dao continuidade ao seu desenvolvimento. Outro editor que parece muito bom eh o QuaRK (Quake Army Knife, ou Canivete Suico para Quake), com muitas ferramentas interessantes, mas eu ainda nao me aventurei a trabalhar com ele, simplesmente porque o WorldCraft ja eh muito bom eh utilizado por 90% das pessoas que mapeiam para Half-Life. Outros editores disponiveis sao o Radiant e Qoole, mas eu nunca mexi com eles. Nessa serie de tutoriais eu falarei apenas do WorldCraft, portanto nao me venham perguntar como que se faz isso ou aquilo em outro editor porque eu nao sei. Outros editores estao listados na pagina de ferramentas. 



Conceitos Basicos Para Edicao de Mapas Para Half-Life 

O tipo de arquivo utilizado pelos jogos baseados no Quake eh o MAP. No WorldCraft, voce pode trabalhar com arquivos MAP ou RMF. O RMF nada mais eh que o MAP otimizado para o WorldCraft, e ele guarda muitas informacoes do ambiente do WorldCraft como agrupamentos, cores sendo usadas, etc, que o MAP nao guarda. Portanto, trabalhe sempre com RMFs, e use MAP apenas para importar/exportar mapas.. 

Os mapas sao compostos basicamente por 3 tipos de elementos: 

  Brushes: Blocos 3D que formam toda a arquitetura do mapa. O chao, paredes, mesas e ate o ceu sao feitos de brushes. Um brush pode ser um simples cubo ou algo muito mais complexo, mas NUNCA um poligogo concavo, sempre convexo, ou seja, sem buracos. 

  Entidades de Brush: Pode-se dizer que sao brushes com "efeitos especiais", como vidros, portas, grades, elevadores, agua, etc. 

  Entidades de Ponto: Tambem "efeitos especiais" ou elementos que sao posicionados em um ponto do mapa e nao sao feitos de brushes, como um foco de luz, fonte de som ambiente, armas, posicao dos jogadores, etc. 

As etapas basicas do meu modo de trabalho seguem mais ou menos esta estrutura: 

  Design: Nao hesite em pegar um lapis e papel e esbocar o seu mapa antes de comecar a trabalhar nele no WorldCraft. Alias, esta eh uma das etapas mais importantes, e economiza muito tempo ja ter a arquitetura basica desenhada em papel. As vezes eu ate desenho no AutoCAD antes de iniciar o trabalho. Tambem vale a pena ja estudar como voce vai criar a jogabilidade no seu mapa, qual o objetivo, o que o jogador tem que fazer, quais os pontos estrategicos, etc. 

  Arquitetura: Crie a arquitetura basica, o chao, os predios e o ceu. Prucure ja cria-los com a textura que voce imagina que sera a final, mas deixe para fazer pequenos ajustes depois. 

  Adicao dos elementos do jogo: Adicione os mostros, Barneys, refens ou seja la o que tenha no seu mapa. Crie as entidades que servirao para dar jogabilidade ao mapa, tipo as bandeiras de um CTF ou um Bomb Target do Counter-Strike. Apos esta fase ja da testar a jogabilidade do seu mapa e saber se vale a pena ou nao dar continuidade a ele. Eh frustrante voce ralar num mapa, ajeitar os minimos detalhes, e no final descobrir que ele nao eh divertido. 

  Ajustes de textura e arquitetura: Faca o mapa ficar bonito. Aplique as texturas adequadas, crie detalhes com brushes, mesas com abajures, cadeiras, pneus joganos num canto, postes de luz, ponha quadros nas parede, esse tipo de coisa. 

  Luzes e efeitos especiais: Posicione as luzes, sons, ventiladores e coisas do tipo fazem o clima do mapa. 

  Ajustes de velocidade: Essa eh a pior fase, e tera um tutorial so para ela. Consiste basicamente em tentar diminuir o numero de poligonos desenhados fazendo pequenos ajustes em brushes e texturas para melhorar a velocidade do jogo (diminuir o lagggg). E ja vou avisando: se voce quer fazer um mapa com grandes areas abertas, va mudando de ideia ou baixando a bola porque o seu mapa vai ficar lagado com certeza. 

  Observe outros mapas: Nao eh bem uma fase, mas uma dica. Quando estiver como expectador numa partida qualquer, ou mesmo camperando, observe cada detalhe do mapa, o trabalho de brushes, as texturas utilizadas, as que texturas emitem luz, onde tem pontos de luz, o som ambiente e tudo mais para copiar depois... 

Cada mod para Half-Life tem o seu conjunto especifico de entidades que podem ser utilizadas. Se voce estiver fazendo um mapa para o Half-Life normal, voce pode colocar armas e monstros a vontade, mas voce nao pode colocar um bando de zumbis escondido no porao de uma casa no Counter-Strike! Portanto cada mod tem o seu FGD, que eh um arquivo com as definicoes das entidades utilizadas nele. 

As texturas utilizadas nos mapas sao agrupadas em arquivos WAD. Sempre que voce usar a textura de um WAD para fazer um mapa, este WAD tem que estar presente no diretorio do mod para o qual o mapa se destina. Se o mapa for de Half-Life normal, o diretorio eh o valve. Falarei mais sobre criacao de texturas e WADs qualquer dia, mas se voce ja quiser tentar, dois bons editores de WADs sao o Wally e o TexMex. 

Apos a criacao do mapa no WorldCraft, eh necessario compila-lo para gerar o arquivo BSP que o Half-Life utiliza. Veja este tutorial para saber mais sobre o processo de compilacao. 



Conceitos Basicos de um Ambiente 3D 

Para quem nao sabe, nos vivemos num universo com 3 dimensoes espaciais. Ha cientistas que querem mostrar que existem mais de 10 dimensoes espaciais, para suportar as teorias de supercordas, que finalmente realizaria o grande sonho de Einstein de unificacao da fisica quantica e a da relatividade. Mas eu acho que estou fugindo do assunto... Bom, mas a nossa mente consegue captar apenas 3 dimensoes, portanto para criar um ambiente realista, precisamos trabalhar em... 3 dimensoes! 

Imagine cada dimensao como um lado que voce pode medir com uma regua. Podemos dizer que uma folha de papel tem 2 dimensoes, voce pode medir apenas a altura e a largura da folha. Um cubo ja tem 3 dimensoes, pois voce pode medir a altura,largura e profundidade. 

A cada "lado" mensuravel damos o nome de eixo. Portanto a folha de papel tem 2 eixos. Se voce desenhar uma linha horizontal nesta folha, estara movendo o lapis pelo eixo X, que representa a largura. Se desenhar uma linha vertical, no eixo Y, que representa a altura. Ate que enfim aquelas aulas de produto cartesiano da escola lhe serao uteis, eh a mesma coisa. Se voce botar o dedo na folha e levantar uns 10 centimetros, voce estara movendo-o pelo eixo Z, a 3a dimensao espacial (parece ate chamada de filme B!). 

Na configuracao padrao do worldCraft (que eu recomendo usar), temos 4 janelas, como neste exemplo: 
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  Camera: Mostra o mapa renderizado em 3 dimensoes onde voce pode navegar como se estivesse dentro do Half-Life. Esta janela tem 3 modos possiveis: Wireframe (apenas as linhas), Flat (solidos de uma so cor) e textured (solidos texturizados). Para mudar, clique em cima do texto camera e selecione o modo desejado. 

  Top (X/Y): Eh o mapa visto de cima, como se voce estivesse olhando a planta da casa. 

  Front(Y/Z): Eh o mapa visto de frente, olhando a frente da casa (porta). 

  Side (X/Z): Eh o mapa visto de lado, olhando a lateral da casa (janelas). 

Se voce criar um cubo, ele ira aparecer nas 4 janelas. Na janela 3D voce ve a sua aparencia real. Na janela top voce pode mudar a largura e profundidade, na janela front voce pode mudar sua altura e largura, e na janela side voce pode mudar sua altura e profundidade. 

Agora, imagine o rolo que seria se enxergassemos 10 dimensoes... 

Instalando e Configurando o WorldCraft 

OBS: Para o entendimento deste tutorial, eh necessario que voce tenha lido os tutoriais de introducao. 

Primeiramente, baixe o WorldCraft 3.3. Este eh o editor oficial de mapas para Half-Life. Baixe tambem os FGDs (arquivo de definicao de entidades) dos mods para os quais voce vai mapear e instale no diretorio do Worldcraft. Baixe o ZHLT (Zoners Half-Life Compile Tools) para Windows. Estas sao as melhores e mais atualizadas ferramentas de compilacao para Half-Life que voce vai encontrar, e eh bom sempre dar uma checada se nao saiu uma versao mais nova com melhorias no site oficial. As ferramentas que vem com o WorldCraft ja estao desatualizadas, e eu acho que ate mesmo dentro da Valve eles usam o ZHLT. 

Instale o WorldCraft e crie um diretorio chamado "zoners" dentro do diretorio do Worldcraft e descompacte o ZHLT dentro deste diretorio. Entre no WorldCraft e selecione o menu Tools -> Options. Eu nao vou detalhar todos os itens de configuracao, talvez ate o faca mediante pedidos e ameacas, portanto se tiver alguma duvida leia o help do WorldCraft que explica direitinho cada item. Mas assim que voce ja tiver uma certa liberdade com o WorldCraft, volte as configuracoes e veja se alguma coisa pode ser melhorada no seu ambiente. As minhas configuracoes preferidas sao as seguintes: 
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Sobre texturas: Quanto mais WADs voce incluir, mais o WorldCraft ficara carregado, e mais memoria sera utilizada na hora de rodar o Half-Life. E lembre-se que todos os WADs incluidos deverao estar disponiveis na hora de jogar o mapa, no diretorio do mod ou no diretorio valve. Portanto, sempre que voce for trabalhar num mapa diferente, verifique o WorldCraft esta usando somente os WADs que voce vai precisar. Eh meio chato ficar mexendo aqui toda hora mas vale a pena. E sempre que voce inserir ou remover WADs, eh bom fechar o WorldCraft e abrir novamente, pois ele as vezes se perde e nao configura as texturas direito. 
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	Game Configurations: Voce deve montar uma configuracao de jogo para cada mod diferente. Isso porque cada mod tem suas entidades e diretorios especificos. 

  Configuration: O mod para o qual voce vai mapear. Clique no botao Edit para criar novas configuracoes de jogos. Por exemplo: Half-Life, Coutner-Strike e TFC. 

  Game Data Files: Inclua somente o FGD do mod. Baixe os FGDs e instale no diretorio do Worldcraft. 

  Texture Format: Sempre WAD3 (para Half-Life) 

  Game Data File: Sempre Half-Life/TCF (para Half-Life) 

  Default PointEntity Class: Entidade de Ponto default que voce quiser. Eu prefiro light ou info_palyer_start. 

  Default SolidEntity Class: Entidade de Brush default que voce quiser. Eu prefiro func_wall. 

  Game Executable Directory: Diretorio onde esta instalado o seu Half-Life (ex: C:\Sierra\Half-Life) 

  Mod Directory: Diretorio do mod (ex: C:\Sierra\Half-Life\valve ou C:\Sierra\Half-Life\cstrike) 

  Game Directory: Diretorio valve (ex: C:\Sierra\Half-Life\valve) 

  RMF Directory: Diretorio onde voce vai guardar os arquivos de mapa RMF. 
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	Build Programs: Para cada mod, eh preciso tambem especificar a localizacao dos programas de compilacao e comando de execucao do Half-Life 

  Configuration: Selecione o mod a configurar (daqueles que foram criados em Game Configurations) 

  Game Executable: Linha de comando para rodar o Half-Life com o mod (ex: C:\Sierra\Half-Life\hl.exe -console ou C:\Sierra\Half-Life\hl.exe -console -game cstrike) 

  CSG Executable: Ferramenta CSG do ZHLT (ex: C:\WorldCraft\zoners\hlcsg.exe) 

  BSP Executable: Ferramenta BSP do ZHLT (ex: C:\WorldCraft\zoners\hlbsp.exe) 

  VIS Executable: Ferramenta VIS do ZHLT (ex: C:\WorldCraft\zoners\hlvis.exe) 

  RAD Executable: Ferramenta RAD do ZHLT (ex: C:\WorldCraft\zoners\hlrad.exe) 

  Place compiled maps in this directory before running the game: Diretorio de mapas do mod (ex: C:\Sierra\Half-Life\valve\maps ou C:\Sierra\Half-Life\cstrike\maps) 


  

Dica: Se quiser saber mais sobre estas configuracoes de mods, no Valve ERC tem um script que ajuda a configurar direitinho todas as opcoes de mods do WorldCraft e explica cada uma detalhadamente. 

Uma Sala Simples ao Ar Livre 

OBS: Para o entendimento deste tutorial, eh necessario que voce tenha lido os tutoriais de introducao e instalacao. 

Este tutorial ira ensinar passo a passo como criar uma sala simples ao ar livre, mostrando varias operacoes basicas do WorldCraft. Uma lista completa das ferramentas do WorldCraft voce encontra na pagina de secao de referencias na pagina de tutoriais. 

  Com o WorldCraft ja instalado e configurado, abra um novo mapa (menu File -> New). Se voce tiver mais de um mod configurado, vai aparecer uma lista para voce selecionar para qual mod o seu mapa sera. Selecione o Half-Life normal. 

  Selecione uma textura de chao clicando no botao Browse ([image: image8.png]Browse.



) na janela de texturas do lado direito. 

  Ajuste o grid para 32 ([image: image9.png]


). 

  Selecione a ferramenta de Criacao de Brush ([image: image10.png]


), clique na janela top e arraste criando um quadrado de 8x8 unidades de grid. Na janela side ou front, ajuste a altura do brush para 1 unidade de grid. Com o cursor em cima de alguma das janelas 2D, tecle ENTER. O brush do chao esta criado e ja podera ser visto na janela 3D: 

  Se na janela 3D nao estiver aparecendo nada, clique once esta escrito Camera e selecione 3D textured. Se aionda nao aparecer nada, a camera deve estar virada. Na pagina de ferramentas do Worldcraft ha uma explicacao de como mexer com a camera. 

Selecionando a area do brush, antes de clicar ENTER:
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Brush criado, apos o ENTER:
[image: image12.png]



  Selecione uma textura de parede. 

  Ainda com a ferramenta de criacao de brush selecionada, clique na janela top e arraste criando um retangulo de 8 unidades de grid de altura e 1 de largura em cima da borda esquerda do brush de chao. Na janela side ou front, ajuste a altura do brush para 4 unidades de grid. Tecle ENTER e uma parede ja estara criada: 

[image: image13.png]comera.




  Selecione a ferramenta de Selecao ([image: image14.png]


) e selecione a parede (na janela 3D eh mais facil). 

  Segure SHIFT, clique na parede na janela top, arraste ate a borda da direita do brush de chao, solte o brush depois solte a tecla SHIFT. Esta eh a operacao de clone, e voce acabou de criar uma copia da parece original: 

  Selecione uma parede, segure CTRL e selecione a outra parede. As duas paredes estao selecionadas. 

  Tecle CTRL-E para centralizar todas as janelas nos objetos selecionados. Tecle CTRL-C (copy) e depois CTRL-V (paste). Com isso, voce criou uma copia das duas paredes exatamente em cima das originais, com as copias selecionadas. Voce poderia copia-las usando o clone, mas preferi apresentar este novo metodo. Nao desfaca a selecao! 

  Clique algumas vezes em qualquer parede selecionada e repare que a selecao nao se desfez, mas os "handles" em volta da selecao mudam cada vez que voce clica neles. Va clicando ate ficar com os handles no modo rotate. 
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  Clique em algum handle e arraste para rotacionar as paredes. Rotacione 90 graus. Para maior precisao, voce pode rotacionar em passos de 15 graus. Se a opcao de configuracao 2D views/Default to 15 degrees rotation estiver ligada (recomendado!), as paredes ja vao rotacionar em passos, se nao, a rotacao vai ser livre e pode ser dificil acertar os 90 graus perfeitamente. Se este for o caso, segure SHIFT que a rotacao sera em passos. O SHIFT tambem serve para fazer rotacao livre caso a rotacao em passos esteja ligada. Nao desfaca a selecao ainda. 

  Mude os handles para o modo resize (clicando na selecao). Segure o handle do meio da esquerda e arraste uma unidade de grid para a direita. Segure o handle do meio da direita e arraste uma unidade de grid para a esquerda. Agora voce ja tem as 4 paredes posicionadas nas bordas do chao. 
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  Agora voce ja pode desfazer a selecao ou clicando em qualquer area fora dos objetos selecionados ou teclando SHIFT+Q 

  Selecione o brush do chao e clone-o na janela side ou front posicionando-o em cima das paredes. Este sera o brush do ceu. 

  Agora voce ja tem um mapa totalmente fechado. Se houver qualquer buraco (LEAK), ele nao vai compilar, e achar leaks eh a parte mais chata ao se mapear. Portanto tenha muito cuidado ao construir o seu mapa para fechar tudo, e cuidado tambem quando estiver alterando brushes irregulares (nao-blocos), que se voce puxa de um lado, ele pode abrir um buraco do outro. Veja este tutorial para saber como encontrar e prevenir leaks. 

  Agora selecione a textura chamada SKY. Na janela de selecao de texturas, ha um campo em baixo que pode ser usado para mostrar apenas as texturas que tem o texto que voce escrever. 

  Selecione o brush de ceu e clique no botao de aplicacao de textura ([image: image17.png]


). 
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  Veja na janela 3D (texturizada) que a textura foi aplicada ao brush. Qualquer brush pintado com a textura SKY eh um brush especial e sera tratado como se fosse um espaco aberto para o ceu no Half-Life. Se voce estiver dentro desta sala e olhar para cima, voce vera o ceu, e do ceu vira a luz do dia que ilimunara a sala. Aleluia! 

  Para selecionar a cor da luz que o ceu emitira, selecione a ferramenta de criacao de entidade ([image: image19.png]


), e clique na janela top bem no meio da sua sala. Um quadrado com um eixo aparecera em todas as janelas 2D, cujo centro sera o centro da entidade de ponto a ser criada. Ajuste na janela side ou front e posicione-o no meio da sala. Tecle ENTER e a entidade sera criada. 

Selecionando a posicao da entidade, antes de clicar ENTER:
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  A entidade criada sera do tipo que voce escolheu na configuracao Game Configuration/Default PointEntity Class. Selecione esta entidade e tecle CTRL+ENTER para abrir a janela de propriedades da entidade. Mude o tipo da entidade (Class) para light_environment. Um mapa so pode ter uma entidade do tipo light_environment. 

Apos o ENTER, entidade criada e selecionada:
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  Para escolher a cor da luz, selecione a propriedade Brightness, clique em Pick Color e selecione a cor. Um mapa de dia deve ter uma luz amarelo clara, de noite mais azulada, um por-do-sol mais vermelho, e assim vai. Teste varias cores que elas mudam bastante o ambiente do mapa. Em Angle, selecione de que direcao vira a luz, visto da janela top. O campo Pitch diz qual a altura do "sol" e deve variar entre -90 e 0. -90 eh meio-dia, a luz vem direto de cima, -45 eh algo como 4 da tarde e 0 a fonte de luz vem direto do horizonte. Sacou? 

Selecao de luminosidade:
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  Para selecionar a aparencia do ceu em si (canyon, cidade, espaco, etc...) que voce quer usar no seu mapa, selecione o menu Map -> Map Properties, e escreva no campo environment map (cl_skyname) o nome do ceu que voce deseja. (veja nas paginas de Tutoriais uma lista completa de ceus disponiveis). Se o seu mapa for para algum mod, veja no diretorio gfx/env do mod quais os nomes dos ceus disponiveis para ele. 
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  Vamos agora botar um vidro dividindo a sala. Clone a parede esquerda e posicione-a no meio da sala. Ajuste o seu tamanho para nao sobrepor nenhum brush, diminua sua espessura para 4 pontos e pinte-a com uma textura de vidro (tipo GLASS_BRIGHT). Selecione o brush e clique no botao ToEntity ([image: image24.png]


) para transformar o brush numa Entidade Brush. Clique Alt+ENTER para abrir as proriedades da entidade. Troque o tipo para func_breakable, sete o Render Mode para Texture, o FX Ammount para 255 e Strength para 1. Agora voce ja tem um vidro quebravel. 

  Coloque tambem um pe-de-cabra pra quebrar o vidro. Eh so criar uma nova entidade do tipo weapon_crowbar ao lado do info_player_start. 

  Agora so falta definir onde o jogador ira aparecer quando o mapa iniciar (spawn). Crie uma entidade dentro da sala e mude seu tipo para info_player_start. Ajuste o angulo para a direcao para a qual o jogador ira comecar olhando. Esta entidade nao deve encostar no chao, deve ficar "flutuando". Se ela encostar em algum brush, voce vai ficar travado ao iniciar o jogo. 

  Pronto, agora voce ja tem um mapa pronto para jogar. Eh so compilar e rodar no Half-Life, mas antes eh sempre bom clicar Alt-P para verificar se nao tem nenhum erro no mapa. Para compilar e jogar, veja o proximo tutorial, Guia de Compilacao. Se quiser, aqui esta o arquivo usado neste tutorial. 

Sala final:
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Como ficou no Half-Life:
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Guia de Compilacao 

OBS: Para o entendimento deste tutorial, eh necessario que voce tenha lido os tutoriais de introducao, instalacao e criacao de sala. 

Introducao 

A maioria das pessoas acha que depois de terminar de modelar um mapa no Half-Life, masta dar um Salvar Como BSP e ja ta pronto pra jogar, mas a coisa eh um pouco mais complicada. Eh importante entender como funciona todo o processo de geracao do mapa final para entender melhor o que eh possivel e o que nao eh possivel fazer no Half-Life, quais os erros que voce pode encontrar e como melhorar a velocidade do seu mapa. 

Em cada frame do Half-Life, estao sendo desenhandos centenas de poligonos que juntos dao a impressao de ser um lugar palpavel. O jogo desenha tudo o que eh visivel na sua posicao atual, descartando o resto, afinal, pra que se preocupar em calcular uma area que nao sera vista? Alem disso, ilumina cada poligono com as luzes que incidem sobre ele. Se esses calculos fossem feitos durante o jogo, se gastaria um poder de processamento tremendo, ficando impossivel jogar. A compilacao serve para dar de bandeja todos estes calculos, assim, o jogo apenas passa para a placa de video exatamente os poligonos que devem ser desenhados, a placa de video faz o seu trabalho de sesenha-los, e o computador fica livre para pensar no jogo em si, nao em como desenhar cada frame. 

O arquivo de mapa final do Half-Life, o BSP (Binary Space Partition tree, ou Arvore de Particao Espacial Binaria), consiste em uma arvore de informacoes dizendo para o Half-Life, para cada posicao possivel no mapa, quais os poligonos que devem ser desenhados e quais as luzes incidentes sobre eles. 

As Etapas da Compilacao 

Etapa 1: CSG (Constructive Solid Geometry, ou Geometria Solida Contrutiva) 

O CSG valida todos os brushes do mapa, verificando se estao dentro da area limite, se todas as suas superficies sao planas e se sao todos convexos. Depois ele separa cada textura que serao usadas dos arquivos WAD e todas as entidades e separa tudo isso para o BSP. 

Etapa 2: BSP (Binary Space Partition, ou Particao Espacial Binaria) 

O BSP pega cada brush e pica em triangulos de acordo com os lugares onde eles se encostam e com as texturas que utilizam e entao verifica se alguma parte de dentro do mapa toca a parte de fora, ou seja, se nao tem nenhum buraco (LEAK). Se houver algum leak, o BSP para por aqui mesmo e nao eh possivel continuar enquanto nao se corrigir o leak (veja este tutorial para saber como encontrar e prevenir leaks). Por fim, o BSP divide o mapa inteiro em portais de acordo com os triangulos criados. Cada portal eh como uma pequena sala, um espaco confinado do mapa. Agora o mapa ja esta num estagio jogavel, mas o Half-Life ainda nao sabe que portais sao visiveis de cada portal, portanto desenhara tudo (lagggg) e tambem nao tem informacoes de luz ainda. 

Etapa 3: VIS (de Visibilidade) 

O VIS anda pelo mapa inteiro e determina quais poligonos sao visiveis de cada ponto do mapa, em cada direcao. Essa etapa eh uma das mais demoradas e pode levar desde alguns segundos ate varias horas, dependendo do tamanho e da complexidade do mapa. Ha uma opcao (-fast) que faz o VIS rodar mais rapido, porem o resultado eh muito ruim (desenha mais do que seria realmente necessario), e deve ser usado apenas fazer compilacoes de testes, nunca para compilacoes finais. 

Etapa 4: RAD (de Radiosidade, ou iluminacao) 

O RAD finalmente ilumina o mapa de acordo com as entidades de luz que ele contem (light, light_spot, and light_environment) e das texturas que emitem luz (veja mais sobre isso aqui). Ele usa as informacoes do VIS para fazer as sombras (se um portal ve o outro, uma luz dentro dele vai iluminar o outro portal). Para comoilacoes finais, existe uma opcao (-extra) que melhora a qualidade da iluminacao, mas aumenta o tempo dela tambem. 

O RAD tambem pode levar de alguns minutos a algumas horas para compilar, dependendo do tamanho e da complexidade do mapa. Ele consome muita memoria, portanto se voce tem pouca e o RAD atingir o limite de memoria e comecar a fazer swap, a compilacao vai ficar incrivelmente lenta e pode nao terminar nunca (eh serio). Para ter uma ideia de quanta memoria livre que ele vai precisar, multiplique o visibility matrix que o RAD informa quando comeca a compilar por 1,5. 

Compilando o Mapa 

Ha quem recomende que nunca se use o WorldCraft para compilar, mas sim algum outro front-end de compilacao como o Tool Box Compilation Controller, que eh muito bom, roda mais rapido e da menos pau. Mas o WorldCraft nao eh tao mau assim. 

O WorldCraft vem com um conjunto de programas para compilacao (csg.exe, bsp.exe, vis.exe e rad.exe) desenvolvido pela Valve quando o Half-Life foi lancado. Mas tem uma cara muito legal chamado Sean 'Zoner' Cavanaugh que pegou eles e melhorou muito, tanto em velocidade quanto em qualidade, portanto voce deve primeiro baixar o ZHLT, e instala-lo para compilar o seu mapa. Veja como instala-lo no Tutorial de Instalacao. 

Eh recomendavel que se feche todos os programas antes de compilar, para liberar o maximo de memoria, que vai ser necessaria para a compilacao. Clique no botao de compilacao ([image: image27.png]


) e voce vera uma das das telas: 

Modo "Smart":
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Modo "Expert":
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Eu sugiro usar sempre o modo Expert. Se voce estiver no modo Smart, clique no botao Expert. Voce tem varios esquemas de compilacao pre-definidos (lista Configurations) como para o Half-Life, Counter-Strike e TFC, e voce pode criar outros clicando no botao Edit do lado desta lista. Estes esquemas descrevem cada etapa da compilacao, que podem variar de acordo com o que voce esta fazendo. Voce pode criar etapas novas (botao New), remover etapas (botao Remove), alterar a ordem de execucao (botoes Move Up e Move Down) e ligar ou desligar etapas sem remove-las do esquema ligando ou desligando o radio box da etapa. 

Para uma compilacao normal de um mapa pequeno como o do Tutorial 3, selecione o esquema Half-Life (full) e clique em Go!. Se a ultima etapa ($game_exe...) estiver ligada, e a compilacao for bem-sucedida, o WorldCraft vai rodar o Half-Life com o seu mapa automaticamente assim que a compilacao terminar (No meu computador isso nao funciona no WC 3.3, mas funcionava no 2.0). 

Em caso de erro na compilacao, conserte-o e rode novamente. Ha uma lista (em ingles) de erros possiveis e suas solucoes no diretorio do ZHLT com o nome de zhltproblems.html. 

Definindo Esquemas de Compilacao 

Os esquemas pre-definidos executam os seguintes comandos: 

  Muda para o diretorio do Half-Life (nao sei porque) 

  Roda o CSG 

  Roda o BSP 

  Roda o VIS 

  Roda o RAD 

  Copia o arquivo final (.bsp) para o diretorio de mapas do Half-Life 

  Copia o arquivo pointfile (.pts) para o diretorio de mapas do Half-Life. Este arquivo pode ser usado para encontrar leaks, usando um metodo descrito neste tutorial. 

  Roda o Half-Life com o seu mapa 

Diferentes esquemas de compilacao sao muito uteis quando se esta desenvolvendo um mapa. Eu normalmente uso 3, de acordo com o que eu estou fazendo no momento: 

Compilacao de testes: Eu crio um esquema fast. O CSG e BSP ficam iguais ao full. Na janeta Parameters, acrescento o parametro -fast no VIS e -chop 128 no RAD (fica muuuuito mais rapido e consome 1/4 da memoria, mas as sombras ficam mais quadradas). Este esquema eh util para mapas que estao ficando grandes ou para uma compilacao rapida. Se o mapa estiver pequeno, voce pode fazer uma compilacao completa que nao vai ser muito lenta, mas conforme o mapa e o tempo de compilacao for aumentando de tamanho, comece a usar estes paramentros. O RAD nao eh necessario para rodar o mapa, ele apenas "deixa bonito", e se deixar de roda-lo, o mapa ficara inteiro iluminado com uma luz forte, sem sombras. Portanto voce pode desliga-lo para testar qualquer coisa que nao seja luz. 

Compilacao de completa: Nunca use o -fast no VIS para compilacoes finais ou para testes de velocidade, pois o -fast faz o mapa ficar muito lento (desenha mais poligonos do que necessario). Para compilacoes finais, eh recomendavel usar o parametro -extra no RAD para melhorar a qualidade da luz, porem o RAD fica mais lento. 

Compilacao para encontrar leaks: Caso voce esteja se debatendo tentando encrontrar leaks no seu mapa, rode apenas o CSG e BSP, acrescente o parametro -leakonly no BSP. Assim, o BSP ira rodar mais rapido com a unica funcao de verificar se ha leaks, mas o mapa nao ficara jogavel. Quando o leak for encontrado, mude para o equema que voce quiser para fazer uma compilacao decente e jogavel. 

Esquema para encontrar leaks:
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Rodando e Testando Mapas 

Os esquemas de compilacao ja copiam o arquivo final do mapa (nomedomapa.bsp) para o diretorio de mapas correto do mod, (valve\maps para Half-Life normal ou nomedomod\maps para mods). Todos os arquivos WAD que voce configurar no WorldCraft deverao estar disponiveis no diretorio valve ou no diretorio do mod, senao nao vai rodar! 

Para rodar o mapa manualmente, crie um atalho para o Half-Life com a seguinte linha de comando: hl.exe -console -dev -particles 10000. O -console serve para liberar o console, o -dev serve para liberar funcoes de extras de desenvolvimento e -particles 1000 ajuda a achar leaks (mais sobre isso depois). Rode o Half-Life por este atalho, clique em Console e escreva: map nomedomapa.bsp. 

Se voce estiver fazendo um para para algum mod ao inves de um mapa para o Half-Life normal, voce tem duas opcoes. Uma eh criar um jogo en LAN para testa-lo (LAN Games, Create Game, selecione o seu mapa na lista e de OK). A outra eh copiar o .bsp do seu mapa para o diretorio valve\maps (dentro do diretorio do Half-Life), copiar os arquivos WAD especificos do mod e que voce estiver usando para o diretorio valve, e rodar o mapa como se fosse do Half-Life normal (como descrito acima). Eu recomendo usar este segundo metodo para testar qualquer coisa que nao tenha a ver com a jogabilidade do mod (tipo testar se os refens podem ser salvos no Counter-Strike), pois roda muito mais rapido. Eh uma boa ideia acrescentar 2 comandos no seu esquema de compilacao para copiar os arquis .bsp e .pts para o diretorio valve\maps. 

O Half-Life possui alguns comandos que sao uteis para desenvolvedores de mapas que sao acionados a partir do console (para abrir o console, tecle ~ (til)). Os mais usados sao estes: 

  noclip: Voce pode atravessar paredes e sair voando. 

  god: Voce fica invencivel (nao perde energia). Funciona para o Half-Life normal, e alguns mods single-player. 

  r_drawflat 1: Desenha as paredes com cores solidas ao inves de usar texturas. Util para saber como os poligonos estao sendo picotados pelo BSP e otimiza-los. (mais sobre isso num tutorial futuso sobre velocidade). Funciona somente em modo Software, nao funciona em DirectX ou GL 

  gl_wireframe 1 ou 2: gl_wireframe 1 desenha linhas onde os poligonos estao cortados e gl_wireframe 2 faz o mesmo mas monstra tambem linhas de poligonos que voce nao ve mas estao sendo desenhados. Funciona somente em modo GL, driver Default, nao funciona com o driver 3dFX. 

  r_fullbright 1: Ignora a iluminacao do RAD e ilunina o mapa inteiro com uma luz forte, sem sombras. 

  pointfile nomedomapa: Quando estiver procurando leaks, este comando carrega o arquivo .pts (do diretorio maps) gerado pelo BSP quando eh leak eh encontrado e mostra linhas que te direcionam ao leak. Veja este tutorial para saber como encontrar e prevenir leaks. 

  gl_clear 1: Quando voce usa o noclip e sai voando atraves de paredes ou fora do mapa, ao inves de preencher o que nao faz parte do mapa com aquela zona (chamada de HOM, Hall Of Mirrors, ou Hall de Espelhos, porque parece o efeito de se botar um espelho contra o outro), preenche este espaco com cores chapadas. Isso eh util para se achar leaks, em conjunto com o pointfile. Funciona apenas em modo OpenGL. 

Como Criar Texturas Para o Half-Life 

Especificacoes Tecnicas 

As texturas usadas nos mapas do Half-Life sao compiladas num arquivo do tipo WAD3,semelhante ao WAD do Quake, so que cada textura tem a sua propria palheta, enquanto que no Quake todas as texturas usa a mesma. Todos os WADs que estiverem na configuracao do WorldCraft na hora da compilacao deverao estar disponiveis no diretorio valve ou no diretorio do mod para o qual o mapa esta sendo desenvolvido, senao o Half-Life nao roda o mapa. Um arquivo WAD nao tem limite de tamanho, mas quanto mais texturas voce usar no seu mapa, mais memoria o Half-Life vai precisar. 

As texturas para o Half-Life devem sempre ser gravadas em BMP 8-bit (256 cores). Ate da pra fazer em outro formato, mas este eh o correto e nao da chabu. Nao ha restricao quanto a palheta de cores, e nao se ganha nada em termos de memoria ou performance se usar a mesma palheta no mesmo set de texturas. 

O tamanho minimo de uma textura eh 16x16 e o maximo 256x256, mas sempre dever ser multiplo de 16 (16, 32, 48, 64, ...), se nao for multiplo de 16, nao funciona, o Half-Life nao aceita! Pra voce ter uma ideia de proporcao, uma parece de uma casa normal teria altura de 128 no Half-Life. 

Os nomes dos arquivos de cada textura devem ter no maximo 15 caracteres mais a extensao .BMP. Os caracteres !, +, - e { tem uso especial (descrito abaixo) e nao devem ser usados a toa. Nao use espacos! 

Tipos de Textura 

  Normal: Uma textura simples qualquer, nada de mais. 
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  Aleatorias: Uma inovacao do Half-Life foi fazer texturas de um mesmo set que sao preenchidas aleatoriamente numa face. Por exemplo, se voce fizer apenas uma textura para um muro muito extenso, pode ficar repetitivo, entao voce faz umas 3 ou 4 texturas (de mesmo tamanho e que batam entre si dos lados) com pequenas diferencas, tipo uma simples, outra com uns tijolinhos expostos, outra com uma rachadura e outra suja e elas serao preenchidas aleatoriamente pela parede. 

Neste exemplo, basta dar o nome -0PAREDE, -1PAREDE, -2PAREDE e -3PAREDE para as 4 texturas e usar a -0PAREDE no muro todo que o Hald-Life vai espalhar as texturas aleatoriamente pelo muro (se nao usar a -0 nao funciona). Entao a regra eh: usar o mesmo nome em todas, precedido de -X, onde X eh um numero de 0 a 9 (portato, voce pode ter no maximo 10 texturas em cada set aleatorio). 

Porem... isso fo funciona em modo Software, nao funciona em GL nem DirectX, infelizmente... mas vale a pena saber. 
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  Animadas: Voce pode fazer um set de texturas animadas. Basta fazer varias texturas de mesmo tamanho, dar o mesmo nome precedido de +X, onde X eh um numero de 0 a 9 (portato, voce pode ter no maximo 10 frames numa animacao). Associe a face a primeira textura do set, e elas texturas animarao eternamente numa frequencia de 10Hz (10 frames por segundo), e isso nao pode ser mudado. 
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  2 Fases: Texturas de 2 fases tem 2 variacoes: ligada e desligada. Como num botao, ele fica apagado e quando vode aperta ele acende. Ou um interruptor de luz. Para isto, basta criar um set de texturas animadas e acrescentar uma textura com o nome +A seguido do nome comum da animacao. A textura +A sera o modo desligado e se voce criar um botao com esta textura, ao pressiona-lo, ele imediatamente mudara para a animacao. Voce pode tambem associar esta textura a um func_wall qualquer e se voce "liga-lo" com um botao, a animacao comeca. Nao eh necessario que seja uma animacao, 2 texturas bastam, como o exemplo abaixo: 
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  Vazadas: Uma textura pode ser vazada, ter buracos para ver atraves nela, como uma grade. Ela deve comecar com { e as partes vazadas devem ser de azul puro (R=0 G=0 B=255), se nao for azul (tipo R=0 G=1 B=255) puro nao vai funcionar, e vai ficar um azulao no meio sua textura. 

Nao basta apenas aplicar a textura ao brush para ela vicar vazada, voce deve transformar o brush em func_wall ou func_illusionary, setar o Rendermode para Solid e FX Ammount para 255. 
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  Liquidos: Uma textura para uma superficie de liquido deve comecar com !. Qualquer face que tenha esta textura tera automaticamente um efeito de agua se mexendo. 
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  Luminosas: Sao texturas que brilham e que emitem luz propria, como lampadas e maquinas de refrigerante do Half-Life. Veja esta pagina para uma lista completa das texturas que emitem luz do Half-Life e como fazer as suas proprias. 

[image: image49.jpg]




 INCLUDEPICTURE "http://mataleone.counter-strike.com.br/tut/texturas/generic88a.jpg" \* MERGEFORMATINET [image: image50.jpg]‘ 'ﬂﬁ‘l




Fazendo as Texturas 

Eu uso o Photoshop para fazer texturas. Ele tem recursos de sobra pra fazer qualquer tipo de efeito. Eh so pegar uma foto e trata-la ou fazer a sua textura propria. Eu nao vou ensinar como mexer no Photoshop, isso ja sai do contexto deste site (mas quem sabe um dia...), vou apenas dar algumas dicas, portanto se voce tiver duvidas, procure algum tutorial ou livro de Photoshop. Vale a pena, pois ele eh poderosissimo. 

O Photoshop trabalha com um formato de arquivo proprio, o .PSD. Eh melhor trabalhar com este tipo de arquivo, para poder usar recursos de layers e efeitos, ja que o BMP nao tem isso. Depois que a textura estiver pronta, salve o seu arquivo, ajuste o tamanho da imagem para o tamanho final da textura (Image -> Image size), Mude para o modo Indexed Color (Image -> Mode -> Indexed Color, Selective), e salve como BMP (File -> Save As ou Save a Copy) 

Uma textura de parede ou chao tem que bater dos lados, ou seja, o lado esquerdo deve ser a continuacao do direito e o de cima a continuacao do de baixo. Se voce vai fazer uma textura para o chao, ela tem que bater horizontalmente e verticalmente, se voce for fazer uma textura para a paredede dentro de uma casa, ela so precisa horizontalmente. Para verificar isso, use o efeito Offset (Effects -> Other -> Offset), e ajuste com a ferramenta de clone. Para ver como a textura vai ficar numa area grande selecione toda a area da textura (CTRL+A), defina como padrao (Edit -> Define Pattern), crie um novo arquivo com tipo umas 8 vezes o tamanho da textura (CTRL+N), e preencha com o padrao (Edit -> Fill, Pattern). 

Se voce pretende fazer texturas para paredes que vao ficar perto de fogo, por exemplo, ja imagina que elas vao ter um tom meio avermelhado. Nao faca isso no Photoshop, faca a parede com a cor que ela eh na realidade. Estes ajustes de cor ficam melhor se forem feitos com luzes no proprio mapa, alem de voce poder usar a mesma textura para outra parede que nao esta proxima do fogo. 

Compilando o WAD 

Existem 2 formas de de compilar um WAD. Uma eh atraves de um programa tipo Wally ou TexMex (disponiveis na pagina de ferramentas), que sao editores graficos simples especificos para criacao de textura e criam WADs compativeis com o Half-Life. Eu uso estes programas apenas para visualizar e remover texturas de WADs ja prontos. 

Para compilar WADs, eu prefiro usar o makels e qlumpy, dois programinhas feitos pela Valve especificos para compilar WAD pro Half-Life. Eles rodam mais rapido, dao mensagens de erro mais claras e dao menos pau. Eles estao disponiveis aqui (wadtools.zip) com um tutorial original da valve e alguns exemplos de textura. 

Para gerar um WAD, copie todos os arquivos BMP para um diretorio, crie um arquivo texto com o nome make.bat e o seguinte conteudo: 

makels . meuwad meuwad.ls
qlumpy meuwad.ls 
Rode o make.bat e pronto. O makels gera um arquivo script (meuwad.ls) que o qlumpy usa para ler os BMPs e gerar o WAD. Simples assim. 

Mapeando para Counter-Strike 

Informacoes Gerais 

Fazer mapas para o Counter-Strike eh bem simples. Baixe o FGD do Counter-Strike, configure o WorldCraft e siga as instrucoes abaixo. 

Os mapas podem ter um arquivo contendo um briefing com o mesmo nome do seu mapa so que com extensao .TXT. Tipo, se o seu mapa se chamar cs_banana.bsp, faca um arquivo cs_banana.txt explicando o tema. 

Use a vontade os WADs contidos no diretorio cstrike, mas eles ja estao meio "manjados" e mapas com texturas originais tem mais chance de serem oficializados. 

Insira 10 pontos de entrada para Contra-Terroistas (entidade info_player_start) e 10 para Terroristas (info_player_deathmatch). Faca com que os membros de cada time aparecam sempre perto uns dos outros para que possam se unir e jogar junto, mas certifique-se que todos os pontos estao separados em pelo menos 128 pontos entre si, para evitar que um trave no outro. 

Eh possivel criar areas onde eh permitido comprar armas, criando um brush com a textura AAATRIGGER e transforme numa entidade func_buyzone. Quando o jogador estiver nesta area ele pode comprar armas. 

Sabe quando inicia uma partida, antes de voce selecionar o seu time e skin, quando fica trocando de camera pelo mapa inteiro? Voce pode tambem estas cameras, basta criar uma entidade trigger_camera no ponto de vista da camera. Crie uma entidade info_target indicando para onde a camera estara virada. De um nome para o info_target (propriedade Name) e ponha este nome na propriedade Target do trigger_camera. Voce pode criar quantas cameras quiser que elas ficarao rotacionando no inicio do mapa. 

Sendo um jogo multiplayer jogado muito na internet, mantenha o r_speeds abaixo de 600. Mapas com r_speeds acima de 600 serao descartados para se tornarem oficiais (mas o cs_italy chegue a 800 em aguns pontos, portanto se o mapa for bom, um canto outro com r_speeds alto nao tem problema) 

Hostage Rescue 

Insira de 3 a 5 refens (hostage_entity); 

Na area de resgate dos refens, crie um brush com a textura AAATRIGGER e transforme numa entidade func_hostage_rescue. Quando os refens entrarem nesta area eles serao salvos. 

Coloque o decalque {HRPOINT (que estao no decals.wad no diretorio cstrike) no meio da area de resgate. 

Nomeie o seu mapa com o prefixo cs_, tipo cs_banana.bsp. 

Defusion C4 Bombing 

Insira 2 alvos para bomba, criando um brush com a textura AAATRIGGER e transformando numa entidade func_bomb_target. O terrorista com a bomba so podera planta-la dentro desta area definida pelo brush. Mantenha os alvos equidistantes dos dois times, com um tempo de 10 a 15 segundos para cada time chegar ao local. 

Coloque o decalque {TARGET or {TARGET2 (que estao no decals.wad no diretorio cstrike) no meio dos alvos. 

Nomeie o seu mapa com o prefixo de_, tipo de_banana.bsp. 

Nao ponha refens neste mapa! 

Capriche na sua explosao. A entidade func_bomb_target tem uma propriedade Target que pode ativar um multi_manager para acionar varias coisas, tipo quebrar caixas, fazer fumaca, vibrar o chao, etc... (Farei um tutorial sobre o multi_manager futuramente) 

Assassination (VIP) 

Insira 13 pontos de entrada para Contra-Terroristas (nao sei porque, mas eh recomendacao oficial). 

Faca pelo 2 ou mais rotas de fuga para o VIP, nao apenas uma. 

Espalhe os terroistas pelo mapa em lugares estrategicos para pegar o VIP fugindo, ja posicionados em torres e locais escondidos. Coloque bastante espaco aberto e varios lugares para sniper. 

Nao ponha refens neste mapa! 

Nomeie o seu mapa com o prefixo as_, tipo as_banana.bsp. 

Na area de fuga do VIP, crie um brush com a textura AAATRIGGER e transforme numa entidade func_vip_escapezone. Quando VIP entrar nesta area, ele estara salvo e os Contra-Terroristas ganharao a rodada. 

Som Ambiente 

Informacoes Gerais 

Ambient_Generic é uma entidade que permite que um arquivo .wav de som específico seja tocado. Para usa-la, basta criar uma nova entidade e selecionar o tipo ambient_generic. (veja como criar uma entidade neste tutorial) As propriedades da ambient_generic sao: 

  Name : Se um nome forcolocado aqui, o ambient_generic poderá ser ativado por alguma outra entidade. 

  WAV name : É aqui que deve ser especificado o arquivo .wav a ser utilizado. Para especificar o diretório do som, deve-se sempre utilizar a barra "/" (exemplo: ambience/industrial1.wav). Se for utilizar algum arquivo de som do Half-Life (encontrado no pak0.pak), apesar do som estar na pasta sound, ela deve ser ignorada (como o arquivo dado de exemplo acima, que se encontra em sound\ambience\industral1.wav). 

  Volume (10=loudest) : Volume do som, sendo 10 o mais alto e 0 o mais baixo (sem som). 

  Dynamic Presets : São "efeitos" pré-definidos para o som (exemplo: Pulse - O som irá "pulsar", variando seu volume de mais alto para mais baixo e vice-versa). 

  Start Volume : Volume inicial do som, até atingir o volume definido em Volume (10=loudest) 

  LFO type : Explicação abaixo. 

  LFO rate (0-1000) : Explicação abaixo. 

  LFO mod pitch (0-100) : Explicação abaixo. - LFO mod vol (0-100): Explicação abaixo. 

A explicação abaixo foi retirada do tutorial para ambient_generic, que pode ser encontrado em Valve ERC.

LFO - Low Frequence Oscillator (Oscilador de baixa freqüência) 

MOD significa Modulation (ou Modulação) e rate é a freqüência (quanto o efeito se repete). Sendo assim, LFO rate trata da freqüência do som, sendo 0 sem efeito e 1000 uma freqüência muito alta. 

Sendo assim, LFO mod pitch significa que o LFO está afetando a altura do som (pitch). Esse efeito também é chamado vibrato. Você provavelmente sabe a diferença de um cantor usando vibrato e o mesmo cantor sem o uso do vibrato. Se você mexer no LFO mod pitch estará causando variações no pitch do som (números altos causarão maior variação - cantores utilizam muito pouco, enquanto uma sirene de ambulância utiliza muito). 

LFO mod vol significa que o LFO está afetando o volume do som. É chamado de tremolo, apesar de que em alguns contextos musicais tremolo e vibrato signifiquem a mesma coisa. Funciona como um pulso no som, e não uma ondulação na altura, como o LFO mod pitch. 

LFO type é a forma da onda que foi utilizada. Cada forma (sqr, tri e rnd) afeta o som de maneira diferente; sqr causará variações no agudo e grave, tri causará transições bruscas e rnd causará transições suaves. 

Resultados Praticos 

Eu realizei alguns testes com o ambient_generic, variando o LFO rate, modpitch, modvol e type. Mantendo o rate em 500 e variando entre os 3 tipos do LFO type, percebi uma grande variação no som usando o tipo 2 (tri), enquanto os outros dois não me pareceram causar mudanças perceptíveis. Depois, testando o LFO modpitch com valor de 50 e deixando o LFO type em 2 (tri), para perceber maiores mudanças), também pude notar uma diferença significativa no som, que ficou totalmente distorcido, irreconhecível se comparado ao som normal sem variações. Já quando deixei LFO modvol com valor de 50 e mantendo o LFO type em 2 (tri), não pude ouvir som algum (como se o ambient_generic tivesse sido invalidado). Então, usando LFO modvol com valor de 50 e mantendo o LFO type em 1 (sqr), o som ficou praticamente igual a quando deixei LFO type 2 (tri) e LFO rate 500.... 

Cheguei à conclusão de que não há muitas maneiras de explicar o funcionamento do LFO, e também é difícil imaginar que som sairá após mexer nas suas propriedades. O jeito é ir tentando e experimentando, fazendo mapas de teste até conseguir algumas mudanças interessantes, que valham a pena... hehe :) 

Flags 

  Play Everywhere: Faz com que o alcance do som seja o mapa inteiro, ou seja, em qualquer lugar do mapa haverá o som determinado pelo ambient_generic em questão. 

  Small Radius: Faz com que o som tenha pouco alcance (determinado por um pequeno raio - small radius") 

  Medium Radius: Faz com que o som tenha médio alcance. 

  Large Radius: Faz com que o som tenha longo alcance. 

  Start Silent: Faz com que o ambient_generic tenha que ser ativado, obrigatoriamente, por alguma outra entidade para que comece a ser tocado. 

  Is NOT Looped: Se essa flag for selecionada, cada vez que o ambient_generic for ativado, o som será tocado apenas uma vez (não ficará se repetindo continuamente). 

Não há como variar o raio de alcance do som sem mexer nos codes da entidade. De qualquer maneira, se o valor do volume for o máximo (10), o menor raio de alcance do som (Small Radius) seria de aproximadamente 800, o raio médio (Medium Radius) seria de aproximadamente 1250 e o raio máximo (Large Radius) seria de 2000. Mesmo assim, a maioria dos sons não é tocada no volume máximo, e também não foram gravados no máximo alcance dinâmico da amostra, portanto esses valores para os raios acabam sendo sempre menores. (retirado de Valve ERC) 

Bom, espero que este tutorial consiga explicar o funcionamento básico do ambient_generic... Agora, para entender mesmo como qualquer entidade funciona, o jeito é ir testando... 

Encontrando e Prevenindo LEAKS 

Lei de Murphy associada a edicao de mapas: 
Paragrafo 1o: "Se voce nuca viu um LEAK, nao se preocupe, cedo ou tarde voce vera." 
Paragrafo 2o: "Voce achou o seu leak facilmente? Entao quando o seu mapa estiver grande o suficiente voce tera outro, e perdera horas procurando-o." 

O que eh um LEAK? 

LEAK significa vazamento. Ou seja, tem um buraco no seu mapa. Os mapas para Half-Life devem ser totalmente fechados, se em alguma parte do mapa houver uma fresta minima que seja, o hlbsp ja vai acusar leak. 

Se voce ver este erro no hlbsp na hora de compilar o seu mapa, voce tem um leak, e vai precisar corrigi-lo: 

Warning: LEAK LEAK LEAK 
Uma mensagem de erro como a seguir no hlbsp eh causada por um LEAK como outro qualquer, e nao quer dizer que suas luzes ou entidades estao com problemas, apenas que foi uma delas que detectou o leak, portanto nao precisa apagar ou editar nenhuma entidade, basta achar o leak: 

Warning: === LEAK in hull 0 === 
Entity light_spot @ (-112,-688, 424) 
Leak pointfile generated 
Warning: === LEAK in hull 1 === 
Entity info_player_start @ (-352,-736, 320) 
Warning: === LEAK in hull 2 === 
Entity info_player_start @ ( 416,-736, 320) 
Warning: === LEAK in hull 3 === 
Entity game_text @ (-1056, 960, 48) 
Mas mesmo com leak voce pode jogar o mapa, so que ele fica sem luz, entao porque nao deixar assim mesmo? Porque vai ficar lentissimo e feio! Afinal quando ha leak, a compilacao termina no bsp, entao o vis nao roda, o que faz o seu mapa inteiro ser desenhado a todo momento, e o rad tambem nao roda, deixando o seu mapa brilhante e feio, sem nenhum efeito de luz. (para saber mais sobre compilacao, veja este tutorial) 

Como achar LEAKS 

  Metodo 1: Procurar visualmente, na raca 

Mude a sua janela 3D para o modo Flat, e saia navegando por ela ate achar o buraco. Se nao achar facilmente, use outro metodo. 

Um leak visto na janela 3D flat:
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  Metodo 2: Blocaum 

Se voce tem uma ideia de onde o leak pode estar, mas nao consegue acha-lo, crie um brush cobrindo toda a area onde voce acha que o leak pode estar. Compile. Se nao der erro de leak, quer dizer que voce o cobriu com o bloco, se der leak, quer dizer que voce nao o cobriu com o bloco, portanto nao esta onde voce pensava, entao aumente ou mova o bloco. Quando voce conseguir cobrir o leak, va diminuindo o tamanho do bloco e compilando. A ideia eh fazer o bloco cobrir o leak e deixa-lo com o menor tamanho possivel, isolando a area do leak. Ai eh so apagar o bloco e voce vai achar facilmente o leak naquela area que ele estava cobrindo. 

  Metodo 3: Usando PointFiles 

Mesmo com leak, o arquivo BSP eh gerado, junto com um arquivo .PTS. Este arquivo .PTS eh chamado de PointFile, e contem informacoes de como o leak foi encontrado pelo hlbsp. No WorldCraft, voce pode carregar este arquivo atraves do menu Map -> Load PointFile. O que eh mostrado eh como se fosse o caminho que o WorldCraft usou para chegar ao leak, mas raramente da para tirar alguma conclusao do que eh mostrado. Para descarregar o PointFile, Map -> Unload PointFile. 

PointFile carregado no WorldCraft:
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O Arquivo PointFile tambem pode ser carregado no Half-Life, o que fica bem mais facil para seguir, pois aparecera uma linha pontilhada percorrendo o seu mapa que vai dar direto no leak. Para fazer isso, voce deve: 

  Copiar o arquivo .bsp e .pts para o diretorio valve/maps, dentro do diretorio do Half-Life (eu recomendo incluir comandos para copiar estes arquivos no seu esquema de compilacao). 

  Rodar o HL com a seguinte linha de comando "hl.exe -dev -console -particles 10000" (eu recomendo criar um atalho com esta linha de comando no seu desktop para ser usado apenas para testes de mapas). 

  Entrar no console e digitar "map nomedomapa" (sem o .bsp). 

  Se voce estiver em modo OpenGL Default, digite no console "gl_clear 1" para preencher os espacos fora do mapa com uma cor solida, nao com HOM (Hall Of Mirrors, aquele efeito que fica repetindo a imagem como se estivesse num espelho) 

  No console de novo, digitar "pointfile" 

  Opcionalmente, digite "noclip" no console para poder atravessar paredes e voar (fica mais facil para seguir a linha). 

  Agora de uma andada pelo mapa ate achar uma linha pontilhada voando. Esta linha passa por dentro e por fora do mapa. 

  Va seguindo esta linha ate que uma hora ela passa pelo leak. 

  Volte pro WorldCraft e conserte o leak :) 

Este metodo eh rapido e eficiente. Se apos corrigir o buraco continuar dando erro de leak, refaca todo o processo novamente, pois certamente voce tem mais leaks, em outros lugares. 

A linha pontilhada saindo pelo buraco no Half-Life:
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  Metodo 4: Envolver o mapa numa caixa 

O pior jeito de contornar leaks eh fazer uma caixa em volta do seu mapa inteiro. NUNCA faca isso. Deixe de ser preguicoso. O seu tempo de compilacao vai aumentar e este tempo poderia ser gasto procurando o leak usando PointFiles, o que deixa o seu mapa menor, mais simples, mais rapido de compilar e mais "certo". Falo, mano? 

O que pode causar um LEAK 

  Descuido 

Um leak pode aparecer por um simples descuido de nao fechar uma certa parte do mapa. Por exemplo, voce pode ter criado um brush para ser o chao que nao chega ate a parede, deixando um buraco entre a parede e o chao. 

  Mexer com grupos ou varios brushs de uma vez 

Ao mexer no tamanho de grupos ou de varios brushes juntos, tome cuidado para que todos os brushes tenham a mesma dimensao no eixo em que voce esta mexendo. As vezes voce pode estar aumentando o tamanho de varios brushes ao mesmo tempo e sem querer abrir um buraco num lugar inesperado sem perceber, como no exemplo abaixo. 

Grupo selecionado que sera editado, sem leaks:
[image: image54.jpg]



Apos mudar o tamanho, aparece um leak inesperado:
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  Entidades brush nao fecham buracos! 

Outro erro comum eh usar uma entidade brush para cobrir um buraco, como uma grade ou vidro numa janela. Se voce quer criar uma janela com grade que de para o ceu, por exemplo, nao basta coloca-la cobrindo o buraco porque entidades nao fecham buracos. Voce deve criar um brush de ceu (com a textura SKY) do lado de fora da parede para fechar o buraco corretamente e ver o ceu quando olhar pela janela. 

Janela sem ceu atras (vai dar leak):
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Janela fechada corretamente com um brush de ceu:
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Usando Sprites, Brilho (Glow) e Rendering Properties 

O env_sprite e o env_glow são entidades muito semelhantes. Ambas servem para que um sprite específico seja usado. A principal diferença entre as duas entidades é que o env_glow serve para fazer sprites permanentes, como por exemplo efeitos de brilho das lâmpadas, enquanto o env_sprite pode ser ativado ou desativado, fazendo com que seja possível o uso de outros efeitos nos mapas que não sejam permanentes (como os efeitos utilizados no Half-Life - Single Player, para simular o teleporte de monstros). 

Os sprites do Half-Life sao figuras 2D estaticas ou animadas, e sao desenhados da mesma maneira nao importando sua posicao relativa ao jogador, ou seja, ele tem a mesma aparencia se visto de lado, de cima, de baixo, etc. Por causa disso, ele deve ser bem posicionado, senao ficara esquisito se visto de um angulo que nao foi previsto. Por exemplo, um sprite de fogo fica muito bom para ser visto de frente, mas se visto de cima, a chama parece estar na vertical. 

Um Sprite de fogo visto de frente e de cima:
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Aqui esta uma listagem completa dos sprites disponiveis no Half-Life. Voce pode tambem retira-los do arquivo PAK0.PAK usando o PakScape ou o PakExplorer e usar o SprView para visualiza-los, ou algum outro programa da secao ferramentas para visualizar/criar sprites 

  

env_sprite 

Com o env_sprite é possível utilizar sprites estaticos ou animados, e possui as seguintes propriedades: 

  Name : Nome da entidade, para poder ser ligada/desligada 

  Sprite Name : Aqui deve-se definir qual sprite será utilizada. Um exemplo seria sprites/fire.spr. Lembre-se de sempre usar a barra "/" ao invés da "\" 

  Framerate : É a quantidade de quadros por segundo que serão mostrados. Serve para aumentar ou diminuir a velocidade da animação (caso queira uma animação mas rápida, o valor deve ser aumentado, e vice-versa) O Framerate padrao é 10. 

  Scale : É a "escala" do sprite. Mudando o valor aqui definido o tamanho do sprite será mudado. Assim, se o valor for 1, o sprite estará em sua escala original, se for 2 o sprite tera o dobro do tamanho, 0.5 tara metade do tamanho, etc... 

  Rendering Properties (Render FX, Render Mode, FX Amount e FX Color): Explicação abaixo 

  FLAGS: O env_sprite tem os os seguintes flags: 

  Start On: Se o env_sprite tiver um nome, ele comeca desligado e precisa ser ativado para aparecer. Este flag faz com que um env_sprite com nome comece ligado. 

  Play once: Faz com que a animação do sprite seja executada apenas uma vez, depois o sprite some. 

  

env_glow 

O env_glow é muito semelhante ao env_sprite, mas mostra apenas com sprites estaticos. O unico caso em que é preferivel usa-lo ao inves do env_sprite, é para fazer brilho em volta de luzes (como o proprio nome ja diz, glow=brilho), usando os sprites sprites/glow01.spr (default), sprites/glow02.spr, sprites/glow03.spr ou sprites/glow04.spr. Lembre-se de usar sempre o Render Mode Glow ou Additive! 

Em env_glow junto a uma luz:
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Como o env_glow mostra apenas sprites estaticos, se você usar um sprite animado num env_glow, como por exemplo o sprite fire.spr, o que vai acontecer é que o env_glow só utilizará o primeiro quadro da animação do sprite. Nesse caso (fire.spr), o fogo ficará "imóvel", sem animação alguma. Se usar o env_sprite, o fogo ficaria animado. 

O env_glow faz com que o sprite seja permanente, e sendo assim não pode ser ativado ou desativado. Deste modo, definir um nome (Name - Targetname) para ele é quase inútil, a não ser que se queira que o env_glow em determinado momento desapareça de vez. Para isso, deve-se usar alguma entidade que possua a propriedade killtarget, e nesse campo deve-se colocar o nome definido no Name do env_glow. Assim, quando a entidade usada for ativada, seu killtarget ativará o env_glow, fazendo com que ele desapareça do mapa (killtarget serve para "eliminar" uma entidade do jogo. Assim, o env_glow irá sumir). Mesmo assim, acho isso tudo desnecessário, afinal pode-se simplesmente usar um env_sprite (ao invés do eng_glow) e desativá-lo, ao invés de usar o killtarget para eliminar o env_glow. 

As propriedades do env_glow sao as mesmas do env_sprite, portanto não serão re-explicadas. A unica diferenca é que ele nao tem Framerate (afinal, é estatico), Scale nem flags. 

  

Rendering Properties 

Abaixo segue uma explicação dos Rendering Properties (propriedades da visualização do sprite). Lembrando que os Rendering Properties são disponíveis para a grande maioria das entidades, não somente env_sprite e env_glow, e por isso irei falar das propriedades de objeto, e não especificamente para sprites (a não ser nos modos Glow e Additive, quase que exclusivos para sprites). 

  Render FX : Controla o comportamento visual do objeto, se ele é normal, se pisca, pulsa, etc. 

  Render Mode : Controla como o objeto será visualizado. Existem 6 modos: 

  Normal (0): Esse é o Rendering Mode padrão. Não causa nenhuma modificação na aparência do objeto. 

  Color (1): Faz com que a aparência da textura do objeto seja substituída pela cor que deverá ser especificada em FX Color. Essa opção não é aplicável às model-based point entities (seriam as entidades baseadas em models, como monstros, por exemplo. Não é aplicável a sprites tambem...). 

  Texture (2): Serve apenas para que o nível de transparência de um objeto possa ser modificado (o nível de transparência será definido pelo FX Amount, quanto menor, mais transparente). O nível de transparência também pode ser modificado se as outras opções do Render Mode forem usadas, e não só o modo Texture. 

  Glow (3): Serve para dar os efeitos de brilho de luz ao redor das luzes. Assim, ao se fazer uma luz qualquer (light), pode-se utilizá-la em conjunto com o env_glow para dar o efeito de brilho ao redor da lâmpada. Ao usar o modo Glow, deve-se usar um certo nível de transparência para que o sprite pareça um efeito de luz, variando o valor do FX Amount. 

  Solid (4): Serve para brushes com texturas vazadas (aquelas que comecam com "{" e tem partes azuis), como grades e portões. Para fazer as partes azuis serem transparentes, e assim dar o efeito de uma grade ou algo do tipo, deve-se usar esse Render Mode (Solid), e usar o valor 255 em FX Amount. 

  Additive (5): Efeito semelhante ao produzido com Render Mode Texture, com a diferença que o modo Additive faz com que, já que vemos o objeto como resultado de uma sucessiva camada de quadros (modo Texture), esses quadros são "adicionados" conjuntamente, dando um efeito mas opaco e de maior brilho. Para fazer os efeitos de teleporte de monstros (Half-Life Single Player), foram utilizados env_sprites com esse Render Mode. 

Para utilizar com sprites (env_sprite e env_glow), os Render Modes que devem ser usados são Glow ou Additive, para que a parte preta ao redor das sprites desapareça e para causar os efeitos ideais dos sprites, mas há exceções, como por exemplo sprites que sejam árvores ou arbustos, e então deve-se usar Render Mode Solid e FX Amount 255, como as texturas de grades, para que a parte azul desapareça e o resto do sprite seja visível como objeto sólido. 

  FX Amount: Serve para modificar o nível de transparência de um objeto. 0 (zero) faz com que o objeto fique totalmente transparente, e 255 totalmente sólido, mas pode-se uasr variações entre 0 e 255. Um valor 153, por exemplo (60% de 255) faz com que o objeto apareça com 40% de transparência (ou 60% de "solidez"). Para grades, deve-se uasr sempre o valor 255 (em conjunto com Render Mode Solid) para deixar as partes azuis transparentes. 

  FX Color (R G B): Funciona apenas com os "Render Modes" que usem o FX Color (Render Mode-Color e Render Mode-Glow). Serve para definir a cor do objeto, em RGB (Red Green Blue - Vermelho Verde Azul). Para usar um valor em RGB, deve-se entender que cada cor varia do 0 (preto, sem cor) ao 255 (cor pura). Portanto, se quiser um vermelho puro, deve-se usar o seguinte valor: "255 0 0". 

Como Preparar Seu Proprio Sprite 

Ingredientes 

Hoje em dia, os mapas comuns estao muito sem gosto! Um spritezinho num canto da sala da o toque de classe que faltava no seu mapa. De um tchans no seu mapa utilizando esta deliciosa receita de sprites do nosso Chef deplantao. 

Como voces ja sabem, um sprite eh uma figura 2D estatica (uma simples imagem) ou animada (varios frames) que pode ser inserida com facilidade em seu mapa, dando aquele charme todo especial que so os chefs internacionais conseguem. Para o preparo deste delicioso prato, voce vai precisar apenas de: 

  1 ou mais imagens formato BMP, 256 cores, 8-bit. 

  O editor de sprites SpriteWizard 

Antes iniciar o preparo desta receita, certifique-se que todas as imagens: 

  Estao no mesmo diretorio 

  Estao no formato BMP, 256 cores, 8-bit 

  Possuem a mesma palheta 

  Possuem o mesmo tamanho 

  O tamanho das imagens deve ser SEMPRE multiplo de 16 (16, 32, 48, 64, ...). 

  O tamanho minimo das imagens eh 16x16 e o maximo eh 256x256 

  As partes pretas das imagens irao ficar transparentes na hora de inserir o sprite no Half-Life. 

Eu vou pegar como exemplo o sprite muzzleflash3.spr, do Counter-Strike. As imagens usadas neste sprite sao estas: 
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Modo de preparo 

  Passo 1: Inicie o Sprite Wizard. Na tela de entrada clique em Next. 

  Passo 2: Clique em Browse e selecione todas as imagens. Se o sprite for estatico, selecione a unica imagem. Clique novamente em Next. 
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  Passo 3: Ordene corretamente as imagens, na ordem em que elas devem ser mostradas na animacao. Clique novamente em Next. 
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  Passo 4: Selecione o tipo do sprite. Os tipos possiveis sao: 
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  Additive: Serao desenhados com transparencia additiva, que na pratica deixa transparentes as partes mais escuras do sprite. A maioria dos sprites do Half-Life sao deste tipo. 

Um sprite Additive e sua palheta:
[image: image68.png]
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  Alphatest: Sao desenhados com transparencia, sendo ultima cor da palheta diz qual eh a cor transparente. Eh aconselhado usar uma cor bem distinta das outras usadas, como neste exemplo: 

Um sprite Alphatest e sua palheta:
[image: image70.png]2
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  Indexalpha: Sao sprites em grayscale, com transparencia relativa ao nivel de cinza do pixel. Pixels pretos ficarao transparentes, os brancos ficarao solidos e os outros tons de ciza terao uma transparencia particial (quanto mais escuro, mais transparente). A ultima cor da palheta sera a cor do sprite. Neste exemplo, este sprite sera uma fumaca amarelada 

Um sprite Indexalpha e sua palheta:
[image: image72.png]
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Variacoes na ultima cor da palheta:
[image: image74.png]
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  Normal: Aparentemente eh o mesmo que Additive, mas todos os sprites do Half-Life sao Additive, portanto use Additive ao inves do Normal, por precaucao. 

  Passo 5: Clique novamente em Next e teste se a animacao esta correta. Se nao estiver, clique em Back algumas vezes e corrija a ordem da animacao, tipo do sprite ou selecione outras imagens, se for o caso. 
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  Passo 6: Clique em Options e selecione o Framerate (numero de frames por segundo) do sprite. Com Framerate 5 a animacao do sera mais lenta, com 10 sera mais rapida. 

[image: image78.jpg]@ Wavelength Sprite Wizard vi1 X

Playyour sprite animation and see the Viewing Options
for playback speed. Click Finish to save it

v





  Passo 7: Clique no botao Finish, de um nome para o seu sprite com a extensao .SPR e o seu sprite ja esta pronto pra servir! 
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Sugestao para servir 

  Para inserir o seu novo sprite no Half-Life, copie o sprite criado para o diretorio valve\sprites, dentro do diretorio do Half-Life. Se este diretorio nao existir, pode cria-lo, ou use o diretorio sprites no mod no qual voce vai usar o sprite, se for o caso. 

  Crie uma nova entidade env_sprite no seu mapa 

  Ponha no campo Sprite Name o nome do seu sprite (tipo sprites/meusprite.spr). 

  Altere o Render Mode para Additive. 

  E pronto! Basta compilar e rodar o mapa para ver o seu sprite em acao! 

Portas 

  

Funcionamento das portas no Half-Life 

Portas no Half-Life sao entidades brush do tipo func_door (porta de correr) ou func_door_rotating (porta giratoria) que sao abertas e/ou fechadas por triggers, botoes ou quando o jogador as "aperta". 

  

Portas de Correr 

Para criar uma porta de correr no melhor estilo Star Trek, crie um brush que sera a porta. Transforme este brush em uma entidade func_door e abra a janela de propriedades (Alt+P). 

Direcione o angulo para o lado que a porta vai correr (quando visto de cima) ou selecione Up para ela abrir para cima ou Down para ela abrir para baixo. 

Ajuste os atributos principais das portas: 

  Name: De um nome unico qualquer a sua porta. A porta deve ter um nome para poder ser aberta atraves de um trigger ou botao, que sera tratado mais adiante. 

  Speed: Eh a velocidade com que a porta se abre. A velocidade padrao eh 100, e se for menor ela abre mais lentamente, se for mais rapido abre mais rapido. O melhor jeito de ajustar a velocidade desejada eh testando. 

  Move Sound: Eh o som que a porta faz enquanto se abre. 

  Stop Sound: Eh o som que a porta faz enquanto termina de se abrir. 

  Delay before close: Eh o tempo, em segundos, que a porta se mantem aberta antes de se fechar sozinha. Se o valor for -1, a porta se mantera aberta, e so se fechara se for acionada novamente. 

  Lip: Quando a porta se abre, ela se desloca inteira para o lado indicado. Se voce der um valor de Lip, ela se deslocara o seu tamanho menos o valor do Lip, ou seja, ficara uma ponta aparcendo. Use valores negatigos para aumentar o deslocamento da porta. 

  Damage inflicted when blocked: Eh o quanto a porta machuca o jogador se ele bloquea-la. 

Ajuste os seguintes flags: 

  Starts Open: Toda porta comeca fechada. Ligue este flag para ela comecar aberta. 

  Passable: Permite ao jogador passar pela porta, ela nao fica solida. 

  Toggle: Se a porta estiver aberta, so se fecha se acionada novamente, e vice-versa. 

  Use Only: Permite abrir a porta "apertando" ela, com a tecla associada ao +use (o default eh a tecla "E") 

  Monsters Can't: Ligue este flag para que os monstros nao possam abrir a porta. 

Se voce criar apenas esta porta, nao sera possivel abri-la sem que haja um trigger ou botao para ativa-la, ou se o flag Use Only nao estiver ligado. Falarei de triggers e botoes mais adiante. 

Veja no fim deste tutorial um exemplo de porta de correr. 

  

Portas Giratorias 

Porta giratoria eh uma daquelas comuns que temos em casa, com macaneta e dobradica. Esta porta eh feita de dois brushes, um eh a porta em si e o outro indica qual o centro de rotacao da porta transformados numa entidade func_door_rotating. Os dois brushes devem estar selecionados na hora de transforma-los em entidade! Este segundo brush de origem deve obrigatoriamente usar a textura ORIGIN e ficara transparente no jogo. 

O default das portas giratorias eh girar no eixo Z, perpendicular ao solo, como uma porta comum mesmo, mas pode ser configurada para girar em outros eixos para fazer um efeito de porta de garagem que se abre para cima, por exemplo (veja os flags abaixo). 

Brushes que compoem a porta (a porta e o verde/branco) mais um de trigger (rosa/preto):
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Os atributos da func_door_rotating sao os mesmos da func_door, adicionados do seguinte atributo: 

  Distance (deg): Eh o quanto a porta vai girar, em graus. O default eh 90. 

Os flags tambem sao os mesmos, mais os seguintes 

  Reverse Dir: Inverte a ordem que a porta gira. 

  One-way: Faz com que a porta se abra apenas para um lado. 

  X Axis: Faz com que a porta gire no eixo X. 

  Y Axis: Faz com que a porta gire no eixo Y. 

Veja no fim deste tutorial um exemplo de porta giratoria. 

  

Abrindo portas com Triggers (ao encostar nela) 

Um trigger eh, literalmente, um gatilho que ativa outras entidades (alvo). Ha varios tipos de triggers no Half-Life, mas so vou falar aqui de trigger_once e trigger_multiple, que sao identicos, a unica diferenca eh que o trigger_once so pode ser ativado uma vez, enquanto o trigger_multiple pode ser ativado varias vezes. Vou me referir ao trigger_multiple, mas tudo funciona para o trigger_once tambem. Na verdade, qualquer entidade que possua algum atributo de Target pode ser vista como um trigger, como num func_breakable, por exemplo, que tem o atributo Target on Break, onde a entidade cujo nome estiver neste atributo sera ativada quando o ele quebrar. 

O trigger_multiple define uma area, e se um jogador passar por ela, a entidade-alvo sera acionada. Para criar um trigger_multiple, crie um brush com a textura AAATRIGGER definindo a area do trigger (se nao usar esta textura, nao funciona!). Nao se preocupe, ele ficara transparente no jogo. 

Edite os atributos do trigger: 

  Target: O nome da entidade-alvo a ser acionada. Se mais de uma entidade tiver o nome indicado aqui, todas elas serao ativadas simultaneamente. Como este eh um tutorial de portas, coloque aqui o nome da porta que o trigger vai abrir. 

  Kill Target: Se voce colocar o nome de uma entidade aqui, ela sera destruida pelo trigger. 

  Delay Before Trigger: Tempo, em segundos, que o trigger esperara antes de acionar a entidade-alvo. 

  Delay Before Reset (somente para trigger_multiple): Tempo, em segundos, em que o trigger aguardara antes que se torne disponivel para ser acionado novamente. 

Opcionalmente, cheque os flags: 

  Monsters: Se estiver ligado, mostros tambem poderao ativar o trigger. 

  No Clients: Se estiver ligado, o(s) jogador(es) nao pode(m) acionar o trigger. 

  Pushables: Se estiver ligado, objetos "empurraveis" (func_pushable) tambem poderao acionar o trigger 

O trigger ja esta pronto! Quando o jogador entrar na area do trigger, ele acionara a porta e ela se abrira. 

  

Abrindo portas com Botoes 

Ao inves de usar triggers, voce pode criar um botao para abrir a porta. Um botao ativa uma entidade-alvo quando voce o "aperta". Crie um brush para o botao e transforme-o numa entidade func_button. Edite os atributos principais do botao: 

  Target: O nome da entidade-alvo a ser acionada. Se mais de uma entidade tiver o nome indicado aqui, todas elas serao ativadas simultaneamente. Como este eh um tutorial de portas, coloque aqui o nome da porta que o trigger vai abrir. 

  Delay Before Trigger: Tempo, em segundos, que o botao esperara antes de acionar a entidade-alvo. 

  Delay Before Reset: Tempo, em segundos, em que o botao aguardara antes que se torne disponivel para ser acionado novamente. 

  Lip: O botao tambem se mexe na direcao do angulo quando acionado, assim como uma porta de correr. O Lip funciona da mesma maneira. 

  Speed: Velocidade com que o botao vai se mexer. 

  Sounds: O som que o botao faz quando eh ativado. 

  Locked Sound: O som que o botao faz quando esta inativo. 

  Health: Se tiver um valor aqui, o botao se ativara com tiros, e esta sera a "energia" do botao, se voce atirar o suficiente para tirar esta energia, ele eh acionado (nunca testei se isso funciona!). 

Opcionalmente, cheque os flags: 

  Don't move: Se estiver ligado, o botao nao se move. 

  Toggle: Se estiver ligado, o trigger nao volta a posicao original, somente se acionado novamente. 

  Sparks: Se estiver ligado, emite faiscas quando desligado. 

  Touch Activates: Eh acionado apenas com o toque, sem precisar aperta-lo. 

Uma coisa interessante que se pode fazer com botoes, eh usar uma textura de dois estados. O Half-Life usa uma versao para o botao desligado e outra para o botao ligado. Procure texturas que tenham o mesmo nome e diferenciem apenas nos prefixos "+0" e "+A", como +0BUTTON3 (desligado) e +ABUTTON3 (ligado). Se voce associar a textuta +0BUTTON3 ao botao, quando voce aciona-lo, a textura muda automaticamente para o seu estado ligado, +ABUTTON3. Quando o botao desativar, a textura volta para o estao desligado. 

Textura com 2 estados:
[image: image81.jpg]




 INCLUDEPICTURE "http://mataleone.counter-strike.com.br/tut/texturas/abutton3.jpg" \* MERGEFORMATINET [image: image82.jpg]



  

Exemplos 

Aqui esta um mapa de exemplo com varios tipos de portas. 

A Porta 1 eh uma porta de correr simples que se abre para cima, com um trigger que a atravessa, sendo que ela pode ser aberta dos dois lados. O Lip da porta eh 8, sendo que quando ela subir, uma pequena parte vai ficar aparecendo no batente da porta. 

Porta de correr simples acionada por trigger:
[image: image83.jpg]



A Porta 2 eh uma porta giratoria comum. Se voce tiver alguma duvida de como criar uma porta desse tipo, abra o arquivo no WorldCraft e veja como foi construida. 

Porta giratoria acionada por trigger:
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Agora temos umas portas mais interessantes. A Porta 3 eh uma porta dupla que se abre para os dois lados, como uma porta de elevador. Na verdade sao duas portas com o mesmo nome. Quando um trigger eh acionado ele ativa todas as entidades que tenham o nome indicano no Target, portanto vai abrir as duas portas simultaneamente. 

O Lip das duas portas eh -1, para que elas se escondam totalmente dentro da parede quando se abrirem. Se o Lip fosse 0, ficariam exatamente na mesma posicao do batente da porta, o que da um efeito esquisito, pois dois brushes sobrepostos ficam piscando. 

E esta porta tambem eh "one-way", pois o seu trigger esta posicionado apenas de um lado da porta. Se voce passar por ela e ela se fechar, nao tem como voltar, pois nao ha nada do outro lado para ativa-la. 

Porta one-way dupla:
[image: image85.jpg]camera





A Porta 4 eh uma porta giratoria com um botao para aciona-la, ela so se abre se voce apertar o botao. A janela de vidro, eh na verdade uma outra porta. Portanto sao duas portas, como no exemplo anterior, a porta em si e o vidro, ambas com a mesma origem e o mesmo nome, acionadas pelo botao. A porta de vidro tem Render Mode Additive ou Texture e FX Ammount 100, para dar transparencia. Se tiver duvidas, abra o arquivo no WorldCraft para entender melhor sobre a sua criacao. 

As duas portas selecionadas separadamente:
[image: image86.jpg]
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Mudando o som dos passos e do ambiente 

  

Mudando os Sons dos Passos de Acordo com a Textura 

Voce ja deve ter reparado em alguns mapas como o som dos passos mudam de acordo com o lugar onde voce esta. Se esta dentro de uma sala eh aquele toc-toc do sapato no chao, se esta na neve aquele crush-crush da neve sendo amassada, uma plataforma de metal faz thung-thung, etc. 

O som dos passos depende da textura sobre a qual voce esta pisando, e voce pode atribuir um som diferente para cada textura que voce faz. Para isso, basta editar o arquivo materials.txt que se encontra no diretorio sound do mod para o qual o mapa vai ser usado. Ou seja, se for um mapa para o Half-Life normal (Deathmatch, Single Player) o arquivo sera o C:\Sierra\Half-Life\valve\sound\materials.txt, se for para Counter-Strike, sera o C:\Sierra\Half-Life\cstrike\sound\materials.txt, etc. (obviamente, substitua C:\Sierra\Half-Life pelo diretorio onde esta instalado o seu Half-Life). O arquivo tem mais ou menos este formato: 


// Half-Life Texture Types. Modify this file only if texture names are changed! 
// 'M' metal, 'V' ventillation, 'D' dirt, 'S' slosh liquid 
// 'T' tile, 'G' grate (Concrete is the default), 'W' wood, 'P' computer, 'Y' glass 
// NOTE: only the first 12 characters of the texture name are used 
// NOTE: a maximum of 512 textures may be tagged in this file 

V DUCT_FLR01 
V DUCT_FLR01A 
V DUCT_FLR02A 
V DUCT_VNT 
V DUCT_VNT2 
V DUCT_WALL01 
V DUCT_WALL02 
V DUCT_WALL03 
V DUCT_WALL04 
V SILO2_COR 
... 

Os proprios comentarios do arquivo ja explicam tudo. O som padrao eh o de concreto. Todas as texturas tem o som de concreto a nao ser que voce defina um novo som no materials.txt. Para definir um novo som para uma textura, inclua uma linha no materials.txt como a seguir: 

V PAREDE1 

Onde a primeira letra eh o codigo que designa o tipo de som que a textura vai emitir, seguido de um espaco e do nome da textura. Os codigos podem ser os seguintes: 

  M - Metal 

  V - Grade de ventilacao 

  D - Chao exterior, de areia/pedras 

  S - Liquido 

  T - Telhado 

  G - Grade de metal 

  W - Madeira 

  P - Computador (som tipo metalico) 

  Y - Vidro 

Existe um limite de 512 texturas que podem ser definidas neste arquivo, e o Half-Life le somente as primeiras 12 letras do nome da textura, portanto nao de nomes com mais de 12 letras para suas texturas. 

Mas existe um porem. Esse recurso eh muito bom para desenvolvedores de mods, onde voce pode criar o materials.txt que quiser, mas eu acho totalmente inadequado para quem faz mapas para mods ja prontos, como mapas Counter-Strike, TFC ou ate mesmo Deathmatch, porque se voce faz um mapa novo com texturas novas, voce nao pode simplesmente substituir o materials.txt original do mod, ou somente as texturas do ultimo mapa instalado vao funcionar direito. Por favor, nao faca isso, nao pega bem substituir arquivos originais do mod, portanto se voce quer por um som na sua textura siga o meu conselho abaixo: 

Para utilizar este recurso em mapas para mods ja prontos (como o Counter-Strike, TFC, etc), abra o materials.txt do mod e escolha uma textura qualquer que use o som que voce quer. Crie a sua textura (voce pode seguir este tutorial para criar as texturas) e de para ela exatamente o mesmo nome da textura que voce escolheu do materials.txt. Tome apenas o cuidado de nao escolher o nome de uma textura que voce quer usar no seu mapa. 

Agora voce deve incluir o seu arquivo WAD (voce ja leu o tutorias de criacao de texturas?) no arquivo BSP do seu mapa, senao quando for rodar o mapa o Half-Life vai usar a textura original ao inves de usar a sua. Para isso, inclua o parametro -wadinclude minhastexturas.wad na linha de compilacao do hlcsg, onde minhastexturas.wad eh o nome do seu arquivo de textruras, claro. A sua janela de compilacao vai ficar mais ou menos assim: 

repare no hlcsg com o parametro -wadinclude
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OBS: Quando foce estiver editando o seu mapa, pode ser que a textura que aparece na janela 3D seja a original, e nao a sua. Isso pode ser meio chato para posicionar a textrura corretamente, se isso acontecer, eh melhor voce dar um nome qualquer para a sua textura para ir usando enquando voce esta desenvolvendo o mapa. Por enquanto ela nao tera o som diferente de passos que voce quer, mas quando voce terminar o seu mapa, troque o nome da textura no WAD e no mapa e compile com -wadinclude. 

  

Mudando todo o som ambiente com env_sound 

Um recurso que eu vejo ser pouco utilizado nos mapas eh o de trocar o som dos passos e do ambiente usando a entidade env_sound. Com ela voce pode dizer qual eh o tipo da sala, e todos os sons dentro dela serao alterados de acordo com o novo ambiente. Esse recurso vai muito alem do que o explicado acima utilizando o arquivo materials.txt, pois voce pode fazer que quando o jogador entre numa caverna, por exemplo, os passos, tiros, vozes e tudo mais tenha um eco peculiar de uma caverna. 

Para trocar o som de um ambiente, voce deve inserir uma entidade env_sound na entrada da sala (usando o Entity Tool - [image: image89.png]


). Selecione o tipo de ambiente em Room Type e de defina o raio de acao da entidade em Radius. Este raio eh a distancia que o jogador deve chegar do env_sound para ele ser ativado. Se voce der o valor de 128, por exemplo, quando o jogador chegar a 128 unidades de grid perto da entidade, o novo som ambiente eh ativado. 

Propriedades do env_sound
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Mas uma vez ativado, o som fica "colado" em voce para sempre, ate que voce passe por um outro env_sound que desligue ele. Para isso, crie outro env_sound com Room Type "Normal (off)" nas saidas da sala. Portanto, voce deve criar um env_sound que liga o som em todas as entradas da sala e um outro em todas as saidas que desliga o som. Mas tome cuidado para que os raios deles nao nao se cruzarem, senao um deles pode nao funcionar. Se voce posiciona 2 env_sounds com raio de 64, por exemplo, deixe-os a pelo menos 128 unidades de distancia um do outro. 

2 entidades env_sound, uma que liga, outra que desliga o som ambiente
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Em mapas multiplayer, voce tambem vai precisar posicionar um env_sound de desligar perto de cada spawn do seu mapa (locais onde os jogadores nascem, definidos pelas entidades info_player_start e info_player_deathmatch), porque se voce morre com um env_sound ativo, quando nasce de novo ele continua ativo, sendo preciso fazer voltar ao normal sempre que voce nasce. 

Usando Ceus e light_environment 

  

Trocando o ceu (imagem de fundo) 

Voce pode trocar o skybox (fundo ou ceu) de um mapa facilmente atraves do menu Map -> Map Properties, colocando o nome do skybox que voce quer usar no campo environment map (cl_skyname). 

Aqui esta uma lista de ceus disponiveis no Half-Life, e na pagina de tutoriais tem os ceus disponiveis para varios mods populares. 

Propriedades mapa
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Selecionando a cor da luz 

Todo o skybox pode projetar uma luz no mapa usando a entidade light_environment. Poderiamos chamar essa entidade de sol, pois ela define de onde vem a luz do ceu, a sua cor e intensidade. Cada mapa deve ter somente uma entidade light_environment, e ela deve ser posicionada no local onde estaria o sol (ou a lua, no caso de um mapa noturno) 

Portanto crie uma entidade light_environment usando o Entity Tool ([image: image93.png]


). A cor padrao eh a cor do sol ao meio dia, bem claro. Para troca-la, selecione a propriedade Brightness, e clique no botao Pick Color. Selecione a cor e a sua intensidade na barra vertical da direita e clique em OK. 

Janela de selecao de cor
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Para achar a melhor cor da luz e ceu para o seu mapa, o jeito eh ir experimentando. Aqui estao alguns exemplos de ambientes diferentes, com seus skybox, pitch (mais sobre isso adiante) e codigo de cor do light_environment, respectivamente: 

	morning, -60, 255 255 128 200
[image: image95.jpg]



	dusk, -35, 245 120 88 200
[image: image96.jpg]




	night, -45, 9 9 15 200
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	alien2, -30, 49 138 30 200
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Procure balancear a cor da luz com o skybox para que nao fique esquisito. Fica estranho por uma luz de dia com um fundo de noite, ou vice-versa. 

	noite com luz de dia!?
[image: image99.jpg]



	dia com luz de noite!?
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Ajustando a direcao da luz 

Alem de posicionar o light_environment onde vai estar o "sol", eh preciso tambem ajustar a direcao e o angulo de incisao da luz sobre o mapa. A direcao eh ajustada no angles da entidade (aquele relojinho), apontando para o lado que a luz vai estar voltada. Normalmente se coloca o light_environment num canto qualquer do mapa e se direciona o angulo para a dentro do mapa, como na figura a seguir: 

Repare no light_environment no canto do mapa, apontando para dentro
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O angulo de incisao ou altura da luz, eh definido pela propriedade Pitch do light_environment, que pode variar de 0 (zero) a -90. Pitch zero significa que a luz vem do horizonte, e -90 diretamente de cima, como o sol do meio-dia. -30 seria algo tipo 4 horas da tarde e -60 como o por-do-sol. 

Aqui estao alguns exemplos de varios pitchs diferentes no mesmo light_environment, para ilustrar melhor: 

O Pitch define o angulo de incisao ou a altura do sol
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Como preparar um mapa para distribuicao (ZIP) 

O intuito deste tutorial eh de mostrar como preparar um arquivo ZIP com o seu mapa e todos os seus arquivos para distribuir sem dar xabu. Eh muito charo receber um mapa zipado dar algum problema na hora de jogar por causa de uma compilacao errada ou ter que ficar extraindo cada arquivo num diretorio separado. 

  

Compilacao do mapa 

Imagino que voce ja saiba como criar e compilar um mapa jogavel. Claro, se nao soubesse, nao teria como distribui-lo. Portanto suponho que voce ja saiba como aontece o processo de compilacao, mas se tiver alguma duvida, verifique o Guia de Compilacao. 

Primeiramente, nunca distrinua um mapa compilado com Fast Vis. O HLVIS pode levar horas, dependendo do mapa, e a opcao "-fast" faz com que ele rode muito mais rapido, mas em compensacao o seu mapa ficara injogavel, de tao lagado. 

Outro ponto importante na hora de compilar um mapa para distribuir, eh tomar cuidado com os arquivos de textura WAD que voce esta usando. Quando voce compilar um mapa editado no Worldcraft 3.3, todos os arquivos WAD que estiverem em uso serao necessarios na hora de rodar o Half-Life, nao tem como selecionar apenas os que estao realmente sendo usados no mapa, o Worldcraft sempre assume que o mapa usa todos eles. Portanto, eh bom que voce exclua todos os arquivos que nao estao sendo usados no seu mapa antes de compilar, senao quem for rodar o seu mapa tera que ter todos eles tambem, senao da pau. 

As texturas em uso podem ser configuradas no menu Tools->Options
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Portanto, se voce estiver usando algum WAD que nao seja padrao do mod, voce tem duas opcoes. Ou voce inclui o WAD dentro do arquivo BSP do mapa durante a compilacao, ou voce vai ter que incluir o WAD no seu ZIP de distribuicao. A melhor opcao eh incluir o WAD dentro do arquivo BSP, pois nem sempre todas as texturas dele sao usadas, e assim voce nao distrubui coisa a mais e tem um arquivo a menos para se preocupar na hora de montar o seu ZIP. 

Existem duas maneiras de incluir o WAD no BSP, voce pode incluir todas as texturas usadas, mesmo aquelas padrao do Half-Life ou do mod, acrescentando o parametro "-nowadtextures" na linha de comando do HLCSG. Se o mapa usa poucas texturas, ou se a maioria delas nao for padrao, esta eh a melhor opcao. 

Ou entao voce pode incluir apenas um WAD especifico no BSP, acrescentando o parametro "-wadinclude texturas.wad" na linha de comando do HLCSG, onde texturas.wad eh o nome do arquivo WAD a ser incluido. Se a maioria das texturas usadas sao padrao, esta eh a melhor opcao. 

Ambos os metodos incluem apenas as texturas do WAD que estao sendo usadas no mapa, e nao todas as texturas do WAD, afinal nao eh necessario. 

usando o "-nowadtextures"
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usando o "-wadinclude"
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Criando o arquivo ZIP 

Para criar o arquivo ZIP para distribuicao, voce vai precisar do WinZip, instale-o se nao tiver! Se o seu mapa nao usa nenhum arquivo novo, basta zipa-lo e ja esta pronto para distribuir! Nao ha necessidade de continuar e fazer nada mais complicado, basta deszipar o seu arquivo no diretorio maps do mod e ja esta pronto para jogar. 

Mas se o seu mapa usa arquivos novos, como sons, sprites ou um ceu diferente, com o metodo explicado aqui basta deszipar todo o conteudo do seu arquivo de distribuicao no diretorio do mod, que todos os arquivos necessarios vao para o seu devido lugar. 

Primeiro crie um diretorio com o nome do seu mapa para montar a estrutura dos arquivos, vou chama-lo de diretorio principal. Dentro dele, crie os diretorios espelhando os nomes dos diretorios onde os seus arquivos novos devem ser colocados dentro do mod. Os diretorios que voce pode precisar criar sao: 

· maps - onde fica o arquivo .BSP. 

· sound - onde ficam os arquivos .WAV. 

· sprites - onde ficam os arquivos de sprite .SPR. 

· models - onde ficam os arquivos de modelos .MDL. 

· gfx/env - onde ficam todos os arquivos do ceu que voce esta usando. 

· PODBot/WPTDefaults - Onde ficam os waypoints para o PodBot. 

· e outros, dependendo do que mais voce vai distribuir 

Estrutura de diretorios espelhando a do mod
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Nem sempre voce vai precisar criar todos eles, apenas aqueles onde voce tem arquivos novos. Agora copie todos os seus arquivos para cada o seu devido diretorio na estrutura criada. Os arquivos WAD devem ficar no diretorio principal. Eh bom tambem fazer um arquivo de texto descritivo com informacoes sobre o mapa e seu nome, email, etc., e deixa-lo no diretorio principal ou no maps. 

No Windows Explorer, entre no diretorio principal, selecione tudo, clique com o botao da direita e selecione o comando "Add To Zip" De um nome ao seu arquivo (normalmente o nome_do_mapa.ZIP) e clique em OK. 

Add to Zip...
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De o nome do arquivo (dentro do Winzip)
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Pronto! O seu arquivo ZIP ja esta criado. Agora basta distribui-lo orientando que ele deve ser descompactado dentro do diretorio do mod (cstrike, tfc, etc). 

Arquivos Zipados. Repare nos nomes dos diretorios iguais aos da estrutura criada
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Arquivos de descricao dos mapas (.TXT) 

A maioria dos mods, como o TFC e o Counter-Strike, podem ter um arquivo de descricao do mapa, que eh apresentado quando ele se inicia ou quando se tecla "I" durante o jogo. Este eh um arquivo de texto comu, criado no Notepad, e deve ter o nome so seu mapa mas com a terminacao .TXT. Se o arquivo do seu mapa se chama banana.bsp, este arquivo deve se chamar banana.txt. Ele deve ficar no diretorio maps, o mesmo onde fica o BSP. 

Como exemplo, aqui esta o conteudo do arquivo de_dust.txt, aposto que voce ja deve ter visto isso no jogo: 
Dust - Bomb/Defuse 
by DaveJ (dv@btinternet.com) 
textures by Macman (MacManInfi@aol.com) 

Counter-Terrorists: Prevent Terrorists 
from bombing chemical weapon crates. 
Team members must defuse any bombs 
that threaten targeted areas. 

Terrorists: The Terrorist carrying the 
C4 must destroy one of the chemical 
weapon stashes. 

Other Notes: There are 2 chemical 
weapon stashes in the mission. 

(Press FIRE to continue) 
  

Arquivo de dependencias (.RES) 

Quando alguem que nao tem o seu mapa instalado se conecta num servidor rodando ele, o Half-Life inicia o download do mapa automaticamente (se o servidor estiver habilitado a isso). Mas apenas o arquivo .BSP eh baixado, sendo que todos os outros ficarao faltando, como os arquivos de sons, ceu e modelos, ficando o ambiente seu mapa prejudicado, e podendo ate gerar erros que o impecam de jogar, se faltar algum arquivo WAD, MDL ou SPR. Para evitar isso e forcar o download de todos os arquivos necessarios, crie um arquivo de texto com a extensao .RES (tipo nomedomapa.res) e deixe-o no diretorio maps. Dentro dele, voce deve incluir a lista de todos os arquivos que o servidor deve enviar para o jogador, com o caminho relativo ao diretorio do mod, como no exemplo a seguir. 

Aqui esta o conteudo arquivo cs_rio.res, usado neste exemplo. Ele contem o nome e o diretorio de todos os arquivos necessarios para rodar o mapa: 
sound/ambience/cv.wav 
sound/ambience/bezerra.wav 
sound/ambience/rua1.wav 
sound/ambience/rua3.wav 
sound/ambience/novela.wav 
sound/misc/apito.wav 
sound/misc/apito2.wav 
sprites/zbeam6.spr 
gfx/env/riolf.tga 
gfx/env/riodn.tga 
gfx/env/rioft.tga 
gfx/env/riobk.tga 
gfx/env/riort.tga 
gfx/env/rioup.tga 
  

Observacoes sobre os arquivos de ceu 

Os arquivos do ceu (imagem de fundo) usados no mapa sao 6. Se o nome do ceu eh banana, por exemplo, os arquivos serao bananaup.TGA, bananadn.TGA, bananart.TGA, bananalf.TGA, bananaft.TGA e bananabk.TGA. As vezes eles podem ser do tipo .BMP ou .PCX, mas da na mesma. Eles formam um cubo que visto de dentro forma a imagem de fundo. Eh como se o seu mapa estivesse dentro deste cubo. 

Todos eles vao no diretorio gfx/env, e se voce esta usando um ceu nao-padrao, deve inclui-los no seu ZIP. 

